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Laura Stack, MBA, CSP is America’s premier expert in
productivity. For over 20 years, her speeches and seminars have
helped professionals, leaders, teams, and organizations improve
personal productivity, performance, and potential. Her Denver-
based company, The Productivity Pro, Inc., provides time :
management workshops around the globe to help attendees A\ =z A
achieve Maximum Results in Minimum Time®. Laura was the ’

2011-2012 president of the National Speakers Association. N, A
Keynoter \
Laura presents over 80 practical, high-energy keynotes and
seminars each year on improving output, lowering stress, and
saving time in today’s workplaces. She is one of a handful of
professional speakers whose business focuses solely on personal
productivity topics. Laura is a high-energy, high-content Clients include
speaker, who educates, entertains, and motivates professionals Starbucks Sodexho
to improve workplace performance. She has earned the e Ball Aerospace
Certified Speaking Professional (CSP) designation, the highest
earned designation given by the National Speakers Association. Wal-Mart Quest
Auth Cisco Systems  U.S. Bank
uthor

KPMG McDonald’
Laura is the author or coauthor of 10 books, including What to _ . c-onaids
Do When There’s Too Much to Do; SuperCompetent; The Nationwide Nestle
Exhaustion Cure; Find More Time; and the bestselling Leave the MillerCoors EMC
Office Earlier: Her newest book, Execution IS the Strategy,. will hit Sunoco Oppenheimer
bookstores in March 2014. Her books have been published in .
twenty countries and translated into seven foreign languages, iyt Uime e
including Japanese, Spanish, Korean, Chinese, Taiwanese, ltalian, MCI Wells Fargo
and Romanian. Laura is a columnist for Training, Productive, Sprint Vi
Time Management, and Success magazines. e RE/MAX
Recognized Productivity Expert Lockheed Denver Broncos
Widely regarded as one of the leading experts in the field of
employee productivity and workplace issues, she has been Spokesperson
featured nationally on the CBS Early Show, CNN, NPR, Mi « X
Bloomberg, WB News, the New York Times, USA Today, the Wall croso erox
Street Journal, the WashingtonPost.com, Entrepreneur, and 3M Day-Timer
Forbes magazine. Laura has been a spokesperson for Microsoft, oVC Office Debot

3M, Skillsoft, Office Depot, and Xerox.
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Setting Up Tasks

A task is a personal or work-related action item that you want to track until it's
completed. A task can occur once or repeatedly. A recurring task can repeat at regular
intervals or repeat based on the date you mark the task complete. For example, you
might want to send a status report to your manager on the last Friday of every month,
or get a haircut when one month has passed since your last haircut.

A. Filter The View In Your Calendar To Display The TaskPad (To-Do
List).

Help  Adobe EDF

[5]wotkWeek [7]ieek [31]Month | 2 Find [ [ Type o contact ko find = | (@) (B8 @!

1. Go to the Calendar. Make sure your | [5.7
Task Pad is showing on the right. If

Calendar
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FEEEEEE 123456
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Type a question for help— »
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April 13, 200
Hlay 2006
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it’s not, go to the View menu and 5=

select Task Pad. o TV
2. Go to the View menu again and 5
click Task Pad View. 2=
3. Select Active Tasks for Selected ;*
Days. The task pad will now only T .
display tasks with a Start Date of S
today or earlier. T
r—
B. Filter the View on the Task Pad ——

Bitems

{4/start| (2} [~] Calendar - Micr... | 4] Student Workbo | 1 ACT! - [peak pro:

1. Right-click in the TaskPad.

|
« OEqS 345PM

2. Select Task Pad Settings, then Show Fields.

3. Add and remove fields until only Icon, Complete, and Subject are showing (in
that order).

Show Fields x|

Maximum number of lines in multi-line mode:

Select available fields From:

Frequently-used fislds j

Available figlds: Shaow these fields in this order:

% Complete + Add - Icon =
Actual Wark — Complete

Attachment Subject

Categories
Company
Contacts

Date Completed
Due Date
Modified

Maotes
Qrganizer
Cnaner

Priority
Recipient Mame j J

Ok | Cancel |

ai;
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C. Remove Completed Tasks From the Task Pad.

1. Right click on the word TaskPad in the Task Pad (make sure you click the
header, not inside the task pad.

| TaskPad

Select Customize Current View.
In the Customize View: dialog box, click on the Filter button.

Click the Advanced tab.

Click on the Field button on the left side in the middle of the box.

Click Frequently-used fields.

Click Complete. The default Condition and Value will automatically be filled in
with Complete, Equals, and No, which you want to keep.

Click the Add to List button.

9. Click OK to return to the View Summary Box.

NN

*

| PR I R S X ) e e e PRCEFRE NI

x|
lPad
Description
Figlds. .. ‘ Icon, Complete, Subject
x|
Group By, ‘ MNone —
— Tasks | More Choices Advanced |sqL |
H=ln
— Sart. .. ‘ Subject {ascending) Find items that match these criteria:
Compleke eguals Mo
— Filker ... ‘ Tasks: Advanced
Other Settings. .. ‘ Fonts and other Table View setting
Remove
Automatic Formatting. .. ‘ User defined fonts on each messaq  Define more criteria:
Figld
Faormat Columns. .. ‘ Specify the display Formats For eac | | J |
Ok, | Cancel | Clear all |

10. Click OK again.
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D. Create a New Task.

On the File menu, point to New, and then click Task.

In the Subject box, type a task name.

Fill in the Start Date for the date you want the task to show up on your TaskPad.

Fill in the Due Date as applicable or different.

If you leave the Start Date and Due Date blank, it will still be in your Tasks list as

a master task list item.

6. Complete any other boxes on the Task and Details tabs for information you
want to record for the task.

7. To make the task recur, click Recurrence, click the frequency (Daily, Weekly,
Monthly, Yearly).

8. C(lick OK, and then click Save and Close.

Gl PN

E. Capture an Email as a Task on the Task Pad.

1. Right mouse click the email (or if you're viewing the email, select File).
2. Select “Move to Folder” from the short cut menu (or File menu).

Inbox - Microsoft Outlook

i Fle Edit Yew Go Tooks Actions Help Adobe PDF Type & question forhelp v

adnew - | 4 2 K | CaReply CReply to Al £ Forward | Y SendiRegeive - | (5 | @) (7 | | (3 Delet As Spam SpamBayes * Eé@snaglt 121 | Region - !
Folder List L

All Falders

2 €5 personal Folders
[ @Tickier
7 Calendar
85 Conkacts
&) Deleted Ttems
[ Drafts
[ 1nbox
B Journal
(3 Junk emai
[ Junk E-mai i
(23 Junk suspects Follow Up v
& [ Laura's Folders ] Mark ss Urread
o notes
[ Outbox
(3 Sent Irems.
|2 Tasks
(1 [ Search Folders

open

Print

=]

| Reply
4| Replyto &
N

=t

5| Forward

Jurk E-mail >

Folder Sizes - <
Data File Management. .. RE: FID RSM Meeting - §

Greeley, Kristin [kristin.gre|

Delete. on

love to Folder. agement.com]

Greatl A
Could you also cc: America, 1. com

Pwill be out of the office next week.

Kiistin Greeley

Colurnbia Managerment Distributors, Inc.

One Financial Center, MAS-515-14-05

Boston, A 02111

517-772-3405

» Fax: B17-772-3533 b

2 Items

4 start 2 [cijes wbia Ma... @B x5 i

3. Select Tasks from the list.
4. Click OK.
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& Inbox - Microsoft Outlook

Pple Edt view Go Tools Actiors Help  Adobe FDF Type & question for help v
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Folder List Inbox =
All Folders +| [ @] From Subject Received W
3 ¥4 Personal Folders i< Mark Buzan Elance project Fri 11j25/2005 4:... =
[ @Tickler (5 Gresley, Kristin RE: FID RSM Mesting - Speaker Confirmatian Fri 11/25/2005 7:.., &
[F] Calendar
(85 Contacts
(8] Deleted Items
(7 Drafts —
(5 1nbox Move liems %]
& 2ournal —
(3 Junk email Mowe the selected kems to the Folder:
£ Junk E-mil 7 Calendar ~
[ Junk suspects 83 Contacts -
8 [ Laura's Folders & Delted tems
| Motes (7 Drafts
[ outbox [ Tnbox
(3 Sent Ttems 58 Joumal
& Tasks (3 Jurk email
2 [ Search Folders (@ urk emal
" [ Jurk suspects
Folder Sizes .
. (3 Laura's folders
Data File: Management... RE: FID RSM Mee | Motes
Greeley, Kristin [kri [ utbox
To: Laura@theproductivity (55 sent tkems
Ce: Chang, America J; Ma & a3
~
Greatl 3
Could you also co: America . Chang@eolurnt nent.com i
Iwill be out of the ofice next week
Kristin Gresley
Columbia Management Distributors, Inc.
One Financial Center, MAS-515-14-05
Boston, MA 02111
617-772-3405
» Fax: B17-772-3533 bt
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74 stant &

5. This will activate a task properties window.
6. Update all of the information accordingly. Use the “Start Date” to indicate when

you want the task to appear on your Task Pad. You can set a reminder here or
even type notes to yourself.

7. Click the “Save and Close” button.

El RE: FID RSM Meeting - Speaker Confirmation - Task

i fle Edt View Insert Format Tools Actions Help
T P Y WA :
;[ save andclose | 4 3 % ] | OvRecurence... | 3l assion Task | 4y % | K | & - & .\@!
[ Task | petais |

Subject: | Create Columbia Management workbock

Due date: Hone ¥ stetus: |Mat Searted v

Start date: | None | Priorty: [Mormal v | % Complete: [1% | %

Clremnder: | il | Owmer: Laura Stack - The Productivty ProfR)
RE; FIDRSM

Aeeting - Speaker ..

[ contacts... ] |

| [[categaries... | | | private (]

A [ B3] dedd P
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F. Assign a Task to Someone Else.

1.
2.
3.

AN

o * N

Select Tasks (or Go, Tasks).
Click “New.”
Select “ Assign task.”

Select the delegate using “To” (just as you would with an email).

Enter the task in the Subject field.

In the Due Date and Start Date fields, enter the desired dates or select from the
calendar.

Attach any files needed for the task.

Type a message with instructions in the Note area.

If you would like to keep an updated copy of the task on your task list or receive
a status report when the task is complete, check the appropriate check boxes.

Task | Details |

This message has not been sent,

To.. | |lohn Stack

Subject: |F‘Iease biook. me a ticket to Boston for December 1 booking
Due dake: |T|'|LI 11}10/2005 w | Skakus: |N|:|I: Skarted W |
Start date: |I"-’I-:|n 114712005 V| Priority: | % Complete: F

Keep an updated copy af this task on nee bask list
Send me a skatus report when this bask is complete

See Columbia Management file for details.

10. Click Send.

Note: The recipient can either Accept or Decline your task request, just like a
meeting request. If accepted, it goes right to Tasks.
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G. View Assigned Tasks by Person Responsible.

1.
2.

Select “Tasks” in the Navigation Pane.
Select by Person Responsible.

n Tasks - Microsoft Outlook

. File Edit “iew Go Tools Actions Help Adobe PDF

Il New ~| Sprind| @ @ 2
Iy Tasks [t @ Subject
o] Tasks
| Tasksin Archive Folders
Current View e
O Simple List 3
"y Dretaled List
(O Active Tasks )

(O Mext Seven Days

(T3 Orverdue Tasks

() By Category

O Assignment

® By Person Responsible
 Completed Tasks

(71 Task Timeline

Open Shared Tasks...
Customize Current View..,

H. Create Your Master Categories List.

N

Create a new task.

Click the “Categories” button in the lower right-hand corner of the window.
Click “Master Category List” button in the lower right-hand corner of the
Categories dialog box. This is the MASTER category list that is used in all
functions of Outlook (Contacts, Calendar, etc.)

Delete any Categories you don’t need for your type of tasks (almost all the
defaults). Click on the unused category term, then click remove. Or hold down
the shift button when selecting to remove a list of categories at once.

Add the category terms you want to use by typing in the text box at the top and
clicking “Add.” Add projects, committees, people, geographical areas, etc., that
describe the categories of tasks you work.
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I. Tag a Task with a Category.

=

Create a new task.

Click the Categories button at the bottom left of the task.

3. Check the appropriate boxes to describe the task (plus the rest of the pertinent
information).

Cateqgaties. .. | Pr

N

4. Save and Close.
J. View Tasks for by Category/Project.

1. Select “Tasks” in the Navigation Pane.
2. Select by Category.

| Categories: Projects: Business (4 items)
4 Cateqaries: @action (2 items)

=| Categories: Chriskina Elakely {2 items)
i’i [ [Laura Stack - The Produckivity Pro, Time Managerent, Getting Things Don...

i"'i [~ Mewer lose anything again--new Super Porkable Computer
| Categories: Create blog on gardening (2 items)

=l Categories: James Patterson (2 items)
i.-*i [~ Re: Foundation ak Denwver
i‘i [ Re: Foundation ak Denver
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Educational Resources by Laura Stack

Subscribe to the Productivity Minute! Watch a one-minute personal performance video each
week, delivered via email: www.theproductivitypro.com/productivityminute/

eBook of screenshots of amazing Microsoft Outlook Task Tricks by Laura Stack:
www.TheProductivityPro.com/download.htm

Download the Laura Stack app for a free eBook! www.TheProductivityPro.com/app

What to Do When There’s Too Much to Do book site: www.TheProductivityPro.com/WhatToDo

Laura’s YouTube channel: http:/ /www.yvoutube.com/theproductivitypro

Link with me! http:/ /www.linkedin.com/in/laurastack

Join our LinkedIn Group, The Productivity Pro® Alumni, to exchange ideas and insights:
http:/ /www linkedin.com/e/vgh /1259217 /

Follow me! http:/ /twitter.com/laurastack

Become a Fan of The Productivity Pro®: www.facebook.com/productivitypro

Sign up for my free weekly productivity newsletter, The Productivity Pro®:
http:/ /www.theproductivitypro.com/r_subscribe.htm

Laura’s blog: http:/ /www.theproductivitypro.com/blog/

Over 150 free articles for download and reprint for your company website, newsletter, or blog:
http:/ /www.TheProductivityPro.com/articles

12 hours of Microsoft Outlook online video training with workbooks:
http:/ /www.TheProductivityPro.com/outlook

FREE downloadable worksheets, checklists, and resources:
http:/ /www.theproductivitypro.com/r free stuff.htm

Take the quizzes FREE from Laura’s books:
http:/ /www.theproductivitypro.com/r quizzes.htm

Get a FREE tip of the day via email:
http:/ /www.theproductivitypro.com/r subscribe 365Tips.htm

Resources for purchase (books, CDs, DVDs, self-study audio, video training, MP3s etc.):
http:/ /www.theproductivitypro.com/t_productivity tools.htm
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